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How to Use this User Guide 

This handbook accompanies the taught sessions for the course. Each section 
contains a brief overview of a topic for your reference and then one or more 
exercises. 

Exercises are arranged as follows: 

 A title and brief overview of the tasks to be carried out; 

 A numbered set of tasks, together with a brief description of each; 

 A numbered set of detailed steps that will achieve each task. 

Some exercises, particularly those within the same section, assume that you have 
completed earlier exercises. Your teacher will direct you to the location of files 
that are needed for the exercises. If you have any problems with the text or the 
exercises, please ask the teacher or one of the demonstrators for help. 

This book includes plenty of exercise activities – more than can usually be 
completed during the hands-on sessions of the course. You should select some to 
try during the course, while the teacher and demonstrator(s) are around to guide 
you. Later, you may attend follow-up Course Clinics at ITLP, where you can 
continue work on the exercises, with some support from IT teachers. Other 
exercises are for you to try on your own, as a reminder or an extension of the 
work done during the course. 

Text Conventions 

A number of conventions are used to help you to be clear about what you need to 
do in each step of a task. 

 In general, the word press indicates you need to press a key on the 
keyboard. Click, choose or select refer to using the mouse and clicking 
on items on the screen. If you have more than one mouse button, click 
usually refers to the left button unless stated otherwise. 

 Names of keys on the keyboard, for example the Enter (or Return) key, are 
shown like this: ENTER. 

 Multiple key names linked by a + (for example, CTRL+Z) indicate that the 
first key should be held down while the remaining keys are pressed; all 
keys can then be released together. 

 Words and commands typed in by the user are shown like this. 

 Labels and titles on the screen are shown l ike this . 

 Drop-down menu options are indicated by the name of the options 
separated by a vertical bar, for example Fi le|Pr int . In this example you 
need to select the option Print  from the Fi le  menu or tab. To do this, click 
when the mouse pointer is on the Fi le  menu or tab name; move the 
pointer to Print ; when Print  is highlighted, click the mouse button again. 

 A button to be clicked will look l ike  this . 

 The names of software packages are identified like this, and the names of 
files to be used l ike this . 
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Software Used 

Excel 2013 

Windows 7 

Files Used 

Exam grades.xlsx  

Invoice lookup.xlsx  

Heal th Club Bookings.xlsx  

Ria View Theatre Club  

Index funct ion.x lsx  

Index Match Function.x lsx  

Index Match Array.x lsx  

Dependant  Cascading dropdown l is ts.x lsx  

Sales and Production.x lsx  

 

 

 

Revision Information 

Version Date Author Changes made 

1.0 15 July 2011 Ian Miller Created 

1.1 21 July 2011 Ian Miller Update for Office 2010 

1.2 16 November 2012 Ian Miller Updates for IT Services 

2.0 14 August 2015 Traci Huggins Update for Office 2013 

 

 

   

 

Copyright 

 

 

 

Traci Huggins makes this document and the accompanying PowerPoint 
presentation available under a Creative Commons licence: Attribution-
NonCommercial-ShareAlike CC BY-NC-SA 

Individual resources are subject to their own licencing conditions as listed. 

Screenshots in this document are copyright of Microsoft. 

The Oxford University logo and crest is copyright of Oxford University and may 
only be used by Oxford University members in accordance with the University’s 
branding guidelines. 



TMSE4  Spreadsheets: Advanced Data Analysis 

 v IT Learning Programme 

 

 





TMSE4  Spreadsheets: Advanced Data Analysis 

 vii IT Learning Programme 

Contents 

1 Introduction ............................................................................. 1 

1.1. What You Should Already Know ......................................................... 1 

1.2. What Will You Learn? ......................................................................... 1 

1.3. Using Office 2013 ............................................................................... 2 

1.4. What is Excel? .................................................................................... 3 

1.5. Where Can I Get A Copy? ................................................................... 3 

1.6. Add-Ins ............................................................................................... 3 

2 Analysis formulas ..................................................................... 4 

2.1. SUMIF and COUNTIF Functions ...................................................... 4 

2.1.1. SUMIF ................................................................................................... 4 

2.1.2. COUNTIF ............................................................................................. 4 

Exercise 2: Using SUMIF and COUNTIF functions ...................................... 4 

2.2. SUMIFS and COUNTIFS Functions .................................................. 4 

2.2.1. SUMIFS ................................................................................................ 4 

2.2.2. COUNTIFS ........................................................................................... 5 

Exercise 3: SUMIFs and COUNTIFs functions ............................................. 5 

3 Lookup Formulas ..................................................................... 6 

3.1. Vlookup – exact match ....................................................................... 6 

Exercise 4: Invoice vlookup – Exact Match ................................................... 7 

3.2. Vlookup – inexact match ................................................................... 7 

Exercise 5: Invoice vlookup – inexact Match ................................................ 7 

4 What-if Analysis ....................................................................... 8 

4.1. Manual What-If Analysis ................................................................... 8 

Exercise 6: Manual What-If Analysis ............................................................ 8 

4.2. What-If Analysis using Scenario Manager ........................................ 8 

Exercise 7: Using the Scenario Manager ..................................................... 10 

4.3. Scenario Summary Reports ............................................................. 10 

Exercise 8: Use formula with the Scenario Manager.................................... 11 

5 Data Validation ...................................................................... 12 

5.1. Validating numerical data ................................................................. 12 

Exercise 9: Numerical Validation .................................................................14 

5.2. Text Length ....................................................................................... 14 

Exercise 9: Text Validation ........................................................................... 15 

5.3. Date Validation ................................................................................. 15 



Spreadsheets: Advanced Data Analysis TMSE4 

IT Learning Programme viii 

Exercise 9: Date Validation...........................................................................16 

5.4. List Validation ...................................................................................16 

Exercise 9: List Validation ............................................................................16 

5.5. Formula Validation ........................................................................... 17 

Exercise 9: Formula Validation .................................................................... 17 

6 Conditional Formatting ......................................................... 18 

6.1. Format a cell based upon the cell value ........................................... 18 

6.2. Format duplicate values .................................................................. 20 

Exercise 10: Conditional formatting by highlighting cells .......................... 22 

6.3. Visualisations ................................................................................... 23 

Exercise 11: Conditional formatting with visualisations.............................. 23 

6.3.1. Data Bars ............................................................................................ 23 

6.3.2. Colour Scales ...................................................................................... 25 

6.3.3. Icon Sets ............................................................................................. 25 

6.4. Manage multiple conditional formats ............................................. 26 

Exercise 13: Managing multiple conditional formats .................................. 27 

6.5. Formula-driven formatting ............................................................. 27 

Exercise 12: Formula driven conditional formatting ................................... 28 

6.6. Clear conditional formatting rules .................................................. 28 

7 Index Match Function ............................................................ 29 

7.1. Index Function ................................................................................. 29 

7.2. Match Function ................................................................................ 29 

7.3. Putting Index and Match together ................................................... 30 

7.4. Using Index/Match to look from right to left ................................... 31 

Exercise 14: Using the Index and Match functions ...................................... 31 

7.5. Index Match Array Formula ............................................................. 31 

Exercise 15: Using Index/Match Array function ......................................... 33 

8 List and Combo Boxes ........................................................... 34 

8.1. Creating a Combo Box...................................................................... 34 

8.2. Creating a Spinner ........................................................................... 35 

8.3. Creating a Check Box ....................................................................... 36 

Exercise 16: Creating Combo Boxes, Spinners and Check Boxes ................ 37 

8.4. How to create a simple cascading dropdown in Excel .................... 37 

Exercise 17: Dependant cascading dropdown lists ...................................... 39 

9 What Next? ............................................................................ 40 

9.1. Further Spreadsheet Courses ........................................................... 40 



TMSE4  Spreadsheets: Advanced Data Analysis 

 ix IT Learning Programme 

9.2. Course Clinic .................................................................................... 40 

9.3. Further Help .................................................................................... 40 

9.4. Downloadable Course Materials – the ITLP Portfolio .................... 40 

Appendix: Student Exercises .................................................... 41 

 

 



Spreadsheets: Advanced Data Analysis TMSE4 

IT Learning Programme x 

Exercises 

Exercise 1 Implement Add-Ins ............................................... 41 

Exercise 2 Using SUMIF and COUNTIF functions ................. 44 

Exercise 3 SUMIFS and COUNTIFS functions ....................... 47 

Exercise 4 Invoice Vlookup – Exact match ............................. 51 

Exercise 5 Invoice Vlookup – Inexact match .......................... 54 

Exercise 6 Manual What-If Analysis ....................................... 55 

Exercise 7 Using the Scenario Manager .................................. 56 

Exercise 8 Use formula with the Scenario Manager ............... 58 

Exercise 9 Data Validation ...................................................... 59 

Exercise 10 Conditional formatting by highlighting cells ....... 62 

Exercise 11 Conditional formatting with visualisations .......... 63 

Exercise 12 Formula driven conditional formatting ............... 64 

Exercise 13 Managing multiple conditional formats .............. 64 

Exercise 14 Index and Match Functions ................................. 66 

Exercise 15 Using the Index Match Array Function ............... 67 

Exercise 16 Lists, Spinners and Combo Boxes ........................ 68 

Exercise 17 Creating a dependent cascading list ..................... 70 



 Spreadsheets: Advanced Data Analysis 

 1 IT Learning Programme 

1  Introduction 
Welcome to Excel: Working with lists and querying external data. 

This booklet accompanies the course delivered by Oxford University IT Services, IT 
Learning Programme. Although the exercises are clearly explained so that you can 
work through them yourselves, you will find that it will help if you also attend the 
taught session where you can get advice from the teachers, demonstrators and even 
each other! 

If at any time you are not clear about any aspect of the course, please make sure you 
ask your teacher or demonstrator for some help. If you are away from the class, you 
can get help by email from your teacher or from help@it.ox.ac.uk. 

1.1. What You Should Already Know 

This session is the fifth in a series that covers Excel from the basics to advanced 
techniques.  We assume you have attended the earlier Excel courses and are familiar 
with opening files from particular folders and saving them, perhaps with a different 
name back to the same, or a different folder. 

The computer network in IT Services may differ slightly to what you are used to in 
your College or Department; if you are confused by the differences ask for help from 
the teacher or demonstrators. 

By the way, did we say that you can ask for help from the teachers or demonstrators  
 ! 

1.2. What Will You Learn? 

In this session we will cover the following topics: 

 Implementing Add-Ins 

 Advanced analysis formulas  

o Sumif 

o Countif 

o Sumifs 

o Countifs 

o Vlookup  

 What-if analysis 

o Manual 

o Scenarios 

 Data Validation 

 Drop down boxes 

 Index / Match Function 

 Conditional Formatting 

o Highlight Cells Rules 

o Top/Bottom Rules 

o Data bars 
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o Colour Scales 

o Icon Sets 

 

1.3. Using Office 2013 

If you have previously used another version of Office, you may find Office 2013 
looks rather unfamiliar. “Office 2013: What’s New” is a self-study guide covering 
the ribbon, Quick Access Toolbar and so on. This can be downloaded from the 
ITLP Portfolio at http://portfolio.it.ox.ac.uk. 

For anyone who prefers not to use the mouse to control software, or who finds a 
keyboard method more convenient, it is possible to control Office applications 
without using a mouse. Pressing ALT once displays a black box with a letter or 
character next to each visible item on the ribbon and title bar (shown in Figure 1). 

 

Figure 1 Keystrokes to Control Ribbon Tabs and Title Bar 
 (Press ALT to Show These) 

After you have typed one of the letters/characters shown, the relevant ribbon tab 
or detail appears, with further letters/characters for operating the buttons and 
controls. 

The elements of a dialog can be controlled, as usual with Windows applications, 
by using TAB to navigate between items or typing the underlined character shown 
beside an item. 

http://portfolio.it.ox.ac.uk/
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1.4. What is Excel? 

Rather like a calculator, spreadsheets were primarily designed to work with numbers. 
You would not expect to type a forty-page essay into a calculator, nor would you in a 
spreadsheet. 

Spreadsheets are used for a variety of different purposes - so much so that to produce 
an exhaustive list of them is almost impossible. Spreadsheets are used in book-
keeping, accounting, marketing, sales analysis, budgets, cash flow, business plans, 
project planning, and production.  The spreadsheet program offers many powerful 
features to help solve complex numerical problems and to detail important areas of 
data. 

1.5. Where Can I Get A Copy? 

If you have a copy of Microsoft Office 2013, then you already have a copy of Excel 
2013. If you are unable to find it on your computer, it may not have been installed and 
you should talk to your IT support contact (or the IT Services Help Centre). 

If you are a member of staff, you can obtain a copy of Microsoft Office 2013 from the 
IT Services online shop. Students can obtain a Microsoft Student Licence, but this 
must be bought through a Microsoft Authorised Education Reseller; the IT Services 
shop can direct you to a suitable reseller. 

1.6. Add-Ins 

In the following exercises you will be using functions and features that are not 
available by default.  These can be added at run time.  Please refer to Exercise 1 for 
instructions. 
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2 Analysis formulas 
Excel provides a variety of functions that summarise data meeting specified criteria.  
This is useful when analysing data. 

2.1. SUMIF and COUNTIF Functions 

SUMIF and COUNTIF are used to sum or count values within a range based on a 
logical test, similar to the IF function. 

2.1.1. SUMIF 

The SUMIF function allows you to sum values that meet a single  criterion only.  The 
general structure of the SUMIF function is shown below. 

= SUMIF(range, criteria, sum_range)   where: 

 range  is the range to evaluate; 

 cr i ter ia  is the search value to be applied to the range; 

 sum_range  is the range containing values you want to summarise. 

2.1.2. COUNTIF 

The COUNTIF function allows you to count values that meet a single  criterion only.  
The general structure of the COUNTIF function is shown below. 

= COUNTIF(range, criteria)   where: 

 range  is the range to evaluate; 

 cr i ter ia  is the search value to be applied to the range 

Exercise 2: Using SUMIF and COUNTIF functions 

Now look at this exercise (page 44) 

 

2.2. SUMIFS and COUNTIFS Functions 

2.2.1. SUMIFS 

The SUMIF formula allows us to find the sum of values meeting a single criterion 
condition.  When you have more than one criterion this function cannot be used and 
you have to use other methods to sum values.   

SUMIFS is simply a plural version of SUMIF and replaces the previous versions 
formula of DSUM.  Using SUMIFS it is possible to find the sum of values in your data 
that meet multiple conditions.  Up to 127 range/criteria pairs are allowed. 

The general structure of the SUMIFS function is shown below. 

 

= SUMIFS(sum range, criteria range 1, criteria 1)   where: 

 Sum range  are the actual cells to sum; 

 cr i ter ia  range  is the range of cells you want evaluated of a certain condition; 

 cr i ter ia  is the condition or criteria in the form of a number, text or formula 
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The order of arguments for SUMIFS differs from the SUMIF function.  The 
sum_range argument is the first argument in SUMIFS, but it is the third argument in 
SUMIF.  Be careful if you are copying and editing these similar functions, make sure 
you put the arguments in the correct order, see Error! Reference source not 
ound. 

 

 

 

 

 

 

 

2.2.2. COUNTIFS 

 

The COUNTIFS function allows you to count values that meet a mult iple  criterion.  
The general structure of the COUNTIFS function is shown below. 

 

= COUNTIFS(criteria range1, criteria1, criteria range2, criteria2…….)   where: 

 Cri ter ia range  is the range of cells you want to evaluate for a particular 
condition; 

 cr i ter ia  is the search value to be applied to the range 

Exercise 3: SUMIFs and COUNTIFs functions 

Now look at this exercise (page 47) 

 

Reminder of SUMIF syntax 
 
=SUMIF(range, criteria, sum_range) 



Spreadsheets: Advanced Data Analysis 

IT Learning Programme 6 

3 Lookup Formulas 
Vlookup searches for a value in the first column of a table and returns a value in the 
same row from another column in the table.   

Syntax 

VLOOKUP(lookup_value, table_array,col_index_num,range_lookup)  

Lookup_value  – The value to search in the first column of the table array.  
Lookup_value can be a value or a reference 

Table_array  – Tow or more columns of data.  Use a reference to a range or a range 
name.  The values in the first column of table_array are the values searched by the 
lookup value 

Col_index_num  – The column number in table_array from which the matching 
value must be returned.  A col_index_num of 1 returns the value in the first column 
in table_array; a col_index_num of 2 returns the value in the second column in 
table_array, and so on. 

Range_lookup  – A logical value of either TRUE or FALSE, that specifies whether you 
want VLOOKUP to find and exact match or an approximate match.  

If TRUE is omitted, an exact or approximate match is returned.  If an exact match is 
not found, the next largest value that is less than lookup_value is returned.  However 
the values in the first column of the table array must be placed in ascending sort order 
otherwise VLOOKUP may not give the correct value 

If FALSE, VLOOKUP will only find an exact match.  The values in the first column do 
not need to be sorted. 

3.1. Vlookup – exact match  

In the below worksheet cell B6  has a vlookup formula in to locate the Descr ipt ion  
based on the StockCode  from the lookup table which is located in a different 
worksheet. 

The formula in cell B6  would be =VLOOKUP(A6,'Stock 
list'!$A$2:$E$19,2,FALSE) 

As the vlookup is exact (False has been input as the range_lookup) the lookup table 
does not need to be sorted 

 

 

 

 

 

 

 

 

 

 

Figure 2 Lookup table 
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Exercise 4: Invoice vlookup – Exact Match  

Now look at this exercise (page 41) 

 

3.2. Vlookup – inexact match 

You will not always require an exact match and therefore an approximate one will 
suffice.   

The formula in cell C4  would be =VLOOKUP(B4,'Grades 
Table'!$A$2:$B$6,2,TRUE) 

As the vlookup is inexact (True has been input as the range_lookup) the lookup table 
must be sorted.  The percentage field has been sorted below from the smallest value. 

When vlookup is performing an inexact match it will return an exact match if found or 
if not found it will return the largest value that is less than the lookup value.  This is 
why it is essential to sort your lookup column in ascending order.  

Therefore in the example below with a percentage value of 63%  the vlookup will 
locate the value of 60%  first in the lookup table and then move to the next value 
which is 70%.   As 70%  is greater than 63%  it will insert the result from the row above 
which is a grade C . 

 

 

 

 

 

 

 

 

 

Figure 3 Percentage grades table 

Exercise 5: Invoice vlookup – inexact Match  

Now look at this exercise (page 54) 
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4 What-if Analysis 

4.1. Manual What-If Analysis 

Manual analysis is where the user changes one or more input cells that affect one or 
more of the key formula cells.  The result of changing values in the input cells can be 
instantly viewed and evaluated.  

Exercise 6: Manual What-If Analysis  

Now look at this exercise (page 55) 

4.2. What-If Analysis using Scenario Manager 

Excel’s Scenario Manager makes it easy to automate your What-If models.  It is 
possible to store different sets of input values for any number of variables and give a 
name to each set.  It is then possible to select a set of values by name, and Excel 
displays the worksheet by using those values. 

From the Data |  Data Tools  tab click on the What- I f  Analysis    button and 

select .  The Scenario Manager  dialogue box should then appear.     

 

Figure 4 Scenario Manager 

 

To create a new scenario click select Add.   

The Add Scenario  dialog box (Error! Reference source not found.) will appear, 
dd a Scenario name for example ‘Best Case’ 

The Changing cel ls  are the cells where the value will change.  They are usually cells 
which have formulas dependent on them.   

Select OK  
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Figure 5 Edit Scenario dialog box 

 

The below Scenario Values  dialog box will appear.  Enter the values required to 
achieve your scenario result.   

To add further scenarios select Add  in the Scenario Values dialog box, once your  

scenarios have been added select OK  

 

 

 

Figure 6 Scenario Values 

 
Once your scenarios have been added they are available to view from the What- I f  

Analysis  , Scenario Manager  window.  Select the Scenario you would like to view 
and click Show . 

You may need to move the Scenarios dialogue box to view the figures changing. 
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Figure 7 Completed Scenario Manager 

 

Exercise 7: Using the Scenario Manager  

Now look at this exercise (page 56) 

 

4.3. Scenario Summary Reports  

Scenario summary reports provide you with a single worksheet summary of the 
different scenarios you have created and displays not only the changing and resulting 
values for all the scenarios you have defined but also the current values in your 
worksheet. 

To create the report, open the workbook which contains the scenarios you want to 
summarise and select the Data tab, Data tools, What-if Analysis, Scenario Manager.  
The below dialogue will appear. 

 

 

Figure 8 Scenario Manager dialog box 
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Select Summary the Scenario Summary dialogue box will appear as below. 

 

 

Figure 9 Scenario summary dialog box 

 
Select Scenario summary report, ensure the Result cells value is blank and select 
OK  

Your report will be created on a new worksheet named Scenario Summary as 
below. 

 

 

Figure 10 Scenario report 

 

Exercise 8: Use formula with the Scenario Manager   

Now look at this exercise (page 58) 
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5 Data Validation 
Data validation is a feature in Excel that allows you to define restrictions on exactly 
what data can or should be entered into a cell.  You are able to configure data 
validation in Excel to prevent users from entering data into cells within a work sheet 
that are not valid. 

There are lots of different ways of using data validation depending on the type of data 
required on an Excel worksheet.  Data validation allows you to set user input 
messages (to let you know that a certain type of data is required for this cell) as well as 
error messages (to let you know that you have entered the wrong data into the cells), 
this helps eliminate user input error. 

We are going to look at some examples of using data validation on a booking system, a 
sample of data from the bookings system is shown below; 

 

Figure 11 Booking system 

5.1. Validating numerical data 

On our booking form we are going to set validation to the ages with the following 
rules; 

 

Figure 12 Age rule for booking system 

 

To put a restriction on our age for the above rules, firstly highlight the cell range 
C7:C13.  Then select Data | Data Validation  

 

Figure 13 Data validation on the ribbon 
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You will then see all of the validation criteria available to you, you will also see tabs 
for Input Message (what the user will see before they enter any data) and an Error 
Alert (when users have input the wrong data);  

Choose Whole number from the drop down arrow (right hand side, then choose 
Between from Data, either type in the ages Or use the cell picker on the right hand 
side and choose the actual cells from the spreadsheet for the Minimum and Maximum 
ages. 

 

Figure 14 Validation criteria 

Note: Ignore Blanks – means if you referenced say C7:C13 as you’re “Source” for the list and only 
C7:C10 had entries, the blank cells would not be shown until such time as they have data in them.  Very 
Handy, in most cases this would be left ticked (it is by default). 

Click on the Input Message tab and type in the following; 

 

Figure 15 Age validation input message 
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Now select the Error Alert tab and type in the following; 

 

 

Figure 16 Error Alert Message  

 

 

Figure 17 Input and Error messages the user sees 

 

If you now click into one of the cells which contains the age you will see the Input 
Message telling you that ages must be in the range 17-100, you can now test the 
validation to check that it works correctly by changing one of the ages to either 16 or 
101, if working correctly you should see the Error Message above. 

Exercise 9: Numerical Validation    

Now look at this exercise (pages 59-61) 

 

5.2. Text Length 

Validation rule can also be used on the Text length, you can set 
or exclude a range of lengths, or specify a minimum length or 
maximum length. If we consider using the rules opposite for 
names;  
 
Select Data | Data Validation | Choose Text length | Between 
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You can then either type the Text Length into the Data Validation dialog box, OR you 
can refer to and select the cells that contain the value on your worksheet. 
 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 18 Text length validation rule 

 

Exercise 9: Text Validation    

Now look at this exercise (pages 59-61) 

 

5.3. Date Validation 

Instead of entering dates onto your worksheet, you could use a formula to set the start 
and/or end dates using validation. 
 
Select the cells in column A under the heading date then select Data | Data 
Validation | Choose Date | Greater than or equal to | =TODAY() 
 
The formula =TODAY() will ensure that Excel uses today’s date in the cells if you 
wanted to have an end date instead of a start date you could use the following 
formula; =TODAY()+6 this would calculate 6 days from today – the +6 can be 
changed to any number of days you require to be the end date from today. 
 

 



Spreadsheets: Advanced Data Analysis 

IT Learning Programme 16 

 

Figure 19 Date validation  

Exercise 9: Date Validation    

Now look at this exercise (pages 59-61) 

 

5.4. List Validation 

One of the most common ways of using data validation is to use a drop 
down list, allowing users to choose from a list, you would need to list 
your data somewhere else on your spreadsheet.  

Select Data | Data Validation | Choose List | use the cell 
reference of the list on your spreadsheet 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 20 List validation  

Exercise 9: List Validation    

Now look at this exercise (pages 59-61) 
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5.5. Formula Validation 

It is common to use formulas when creating validation rules, we 
could have a rule that offers discount only on orders for £10 or 
more; 

 

Select Data | Data Validation | Choose Custom | =IF(E7<10,FALSE,TRUE)
  

 

Figure 21 Data validation using a formula 

 

Exercise 9: Formula Validation    

Now look at this exercise (pages 59-61) 
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6 Conditional Formatting 
Conditional formatting can help you to analyse and answer specific questions about 
your data by making it easy to highlight interesting cells or ranges of cells, emphasize 
unusual values or visualise data by using data bars, colour scales and icon sets. 

A conditional format changes the appearance of a cell or range based on the condition 
or criteria set.  If the condition is true, the cell or range is formatted based on that 
condition.  It the condition is false the cell or range is not formatted. 

It is only possible to conditionally format by referencing to cells in the same worksheet.  
It cannot reference to cells in other worksheets or workbooks. 

Below are various types of conditional formatting. 

6.1. Format a cell based upon the cell value 

One of the simplest conditional formatting options is to apply a change of background 
colour of cells depending on their value.   

Conditional formats can be applied to values , dates  or tex t .  Formatting values  you 
can highlight values greater than or less than or between values.  Formatting tex t  you 
can highlight text that begins with, ends with or contain specific characters.  For 
dates  you can highlight cells such as today, tomorrow, in the last seven days, last 
week and this week.  The format will be based upon the current date. 

They can also be used to highlight cells which contain dupl icate values .   

All of these options are available to you on the Home  tab on the ribbon in Styles /  

Condi t ional  Format t ing /  Highl ight  Cel l  Rules , see Figure 22. 

 

Figure 22 Highlight cell rules  
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Other conditional formats available for highlighting cells are Top/Bottom Rules  

which is located just below the Highl ight  Cel l  Rules  located in Error! Reference 
ource not found..  There are various options available which are shown below in  

 

 

Figure 23 Top/Bottom Rules  

 
When conditionally formatting cells, select the range of cells you would like to 
highlight with the rule you would like to apply.  In the below worksheet the grades in 
cells B4 to B15 have been selected. 

 

Figure 24 Selecting % cells 

 

Select the Condi t ional  Formatt ing  menu from Home |  Sty les |  Condi t ional  
Formatt ing  and for this example Top|  Bot tom Rules  has been selected followed by 
Above Average.  

The following dialog box will then appear.  Click on the drop down arrow and select 
an appropriate highlight colour.  If there is not a suitable colour select Custom  
Format  and create your own background colour.  Then select OK  
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Figure 25 Formatting background colour 

 

The cells which are above average will then be highlighted.  See below. 

 

 

Figure 26 Conditional Formatting results  

 

6.2. Format duplicate values 

Conditional formatting allows you to format duplicate values within a range of cells – 
this will allow duplicate values to be automatically picked up rather than have to look 
through reams of data. 
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Firstly highlight the column (or row) that you 
need to find duplicate values from. Then select 
the conditional formatting icon from the ribbon 

 

Select  Highl ight  Cel ls  Rules   

Then select Dupl icate Values  

 

  

 

Figure 27 Lookup table  

You will then see the following option box for you to choose in which way you 
would prefer to format your duplicate values.   

 

Clicking on the dropdown box next to values wi th , will allow you to specify as to 
whether you would like both the numbers/text and the cell coloured or whether 
to choose to have either just the numbers/tex t  or just the cells. 

 

 

 

 

 

 

 

 

 

Figure 28 Cell or text colour 

 

By selecting the Custom Format  option it allows you to choose a more variety of Colour |  
Fi l l  |  Fonts |  Borders . 

 

 

 

 

 

 

Figure 29 Custom format  
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When you have chosen the duplicate values option this is what will happen – as 
Excel will pick up that there are 5 duplicate values of 16 in this cell range. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 30 Results  

Exercise 10: Conditional formatting by highlighting cells  

Now look at this exercise (page 62) 
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6.3. Visualisations 

Visualisations are between raw data and charts.  With a few clicks you can express 
numbers in a visual manner.  Various visualisation options are available by 
selecting Home | Styles | Conditional Formatting | Data Bars or Colour Scales or  
Icon Sets.  See Data Bars.  

 

Figure 31 Data Bars 

Exercise 11: Conditional formatting with visualisations  

Now look at this exercise (page 63) 

6.3.1. Data Bars 

Data bars are a quick way to insert cell sized charts into your worksheet.  They can 
either be displayed in addition to the value in the cell or you can just show the graph 
in the cell and remove the values. 

In the below worksheet there are sales returns for each month and region.  By 
selecting a range of cells you would like to compare, for example each month’s sales 
return, you can insert Data Bars to show visually the lowest to highest sales return.   

Select the cells in range D2:D7 for January sales and select Home | Styles | 
Conditional Formatting | Data Bars.  See Data Bars above.  Then from the options 
available select either a Gradient Fill or Solid Fill. 

Each month can subsequently be selected and different colour Data Bars can be 
applied.   

There is also an option to only display the data bars.  This however can be 
meaningless unless the values are visible in a nearby cell.  One way to overcome this is 
to refer to the cell next door by a formula eg =D8, then select the range of cells where 
you require Data Bars only to appear and select Home | Styles | Conditional 
Formatting | Data Bars and select More Rules ,which is located below the Data Bars 
menu.   
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The New Formatting Rule dialog box will appear, see New Formatting Rule dialog 
box.  From the Edit the Rule Description / Format all cells based on their values 
select Show Bar Only tick box.  Select a colour from the Bar Appearance section 
and select OK 

 

Figure 32 New Formatting Rule dialog box  

 

The example below shows data bars in a different colour for each month, for 
example in the month of February it has Data Bars only visible by referring with a 
formula to the adjacent cells, for example E8 contains the formula =D8, cell E9 
has a formula or =E9 and so on.    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 33 Results  
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6.3.2. Colour Scales 

Colour scales are similar to data bars however they allow you to display varying colour 
scales to represent your cell values.  For example the lowest number can be red, 
middle number amber and the top number green, depending on what you require.  
See below for some of the options. 

 

Figure 34 Lookup table  

6.3.3. Icon Sets 

Icon sets allow you to set a value for each icon. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 35 Icon Sets  
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Figure 36 Icon Sets Values  

6.4. Manage multiple conditional formats 

There are times when you may need to create more than one conditional formatting 
rule for a range of cells. This is done by firstly selecting the cell range you require to 
include in the formatting rule. Then selecting Condi t ional  Format t ing |  Manage 
Rules |  New Rule.  

 

 

 

 

 

 

 

 

 

 

 

Figure 37 New rules  

 

You now have the option to choose what formatting is required for the cells.  Select 
Format Only Cells that Contain. 

 

 

 

 

 

Figure 38 Types of rules  
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Conditional formatting gives you the option as shown below to format cells with a 
variety of actions.  Select Cel l  Value |  Equal  to  |  type in A* .   Then you need to 
select Format to choose what colour you would like to format the cells to. 

 

 

 

 

 

 

Figure 39 Formatting cells with actions 

 

The Conditional Formatting Rules Manager as you can see from the diagram below 
allows you to add as many rules as required.  It also allows you the option to Edi t  

Rule  and Delete Rule .  

 

 

Figure 40 Edit rules  

Exercise 13: Managing multiple conditional formats  

Now look at this exercise (page 64) 

 

6.5. Formula-driven formatting 

As we have already seen there are many ways to use conditional formatting to quickly 
highlight important information. Sometimes however the built-in formatting does not 
go quite far enough.  It is possible to add your own formula to a conditional 
formatting rule and give the spreadsheet the power to do what the built-in rules 
cannot do. 

Formula-Driven formatting works in the following way; select the cell range that you 
want to add a formula driven conditional formatting to then select Condi t ional  

Format t ing |  New Rule |  Use a formula to determine which cel ls  to  format   as 
shown below: or 
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Figure 41 Formula driven 

 

Support that we want to format all the percentage grades that are below average. 
To do this we need to add the formula =B4<AVERAGE($B$4:$B$:15) as shown 
below:  

 

 

 

 

 

 

 

Figure 42 Using an average formula  

Exercise 12: Formula driven conditional formatting   

Now look at this exercise (page 64) 

 

6.6. Clear conditional formatting rules 

If you need to remove any conditional formatting you can either Clear  Rules /  Clear 

Rules  form Enti re Sheet  or select the cells which you want to remove your 
formatting from and select the option to Clear Rules /  Clear Rules from Selected 

Cel ls  see Clear Conditional Formatting Rules 

 

 

Figure 43 Clear Conditional Formatting Rules 
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7 Index Match Function 
Index Match let you perform lookups from data that Vlookup cannot and run much 
faster on large spreadsheets than the Vlookup function.  Index Match works very well 
if your lookup data is not in the first column, or you want to look to the left of the 
lookup data, rather than to the right (which is all Vlookup can do). 

For many Excel users the Vlookup does just what they need, however there are three 
scenarios where Vlookup falls short, that is where Index Match comes in handy; 

 Vlookup can only look from left to right 

 Vlookup is prone to error, especially in big spreadsheets 

 Vlookup slows down big spreadsheets 

7.1. Index Function 

The Index function has a very simple job – it looks in a column of data and returns a 
value from the row that you specify, an example of an Index function in action: 

 

 

Figure 44 Index function 

 

Here with have used the Index function to select the cell range 
A2:A8 (the countries) and we want it to return the 3rd value from 
this range, the actual result is; India 

 

7.2. Match Function 

The Match function also has a simple job – it looks in a column of data and returns 
the row number of a value that you specify, it is a bit more complicated than the Index 
function.  Below is an example of how the Match function in action.  Lets assume we 
have a column of names and we want to know which row Bridget is found in, we will 
assume that all names only appear once; 
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Figure 45 Match Function 

The difference with this function compared to the Index function is that after we have 
selected the cell criteria and cell range we add a zero at the end of the function.  By 
entering a zero as the last parameter in the formula we are telling Excel to look for an 
exact match. 

7.3. Putting Index and Match together 

Now that we have an understanding of how both Index and Match work on their own 
let’s put them together to create an Index Match function that we can use in replace of 
Vlookup. 

Firstly let’s start with a simple example an use Index/Match to do something that the 
Vlookup function can also do – find the name of the person from France. 

First let’s look at the Vlookup function you would use to find this result: 
=VLOOKUP(“France”,A2:A8,0).  This formula is “looking for France in column A nd 
if you find it, return the value from the second column in the same row, if you don’t 
find France, return an error”. 

 

Figure 46 Using the Index/Match function together 
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The formula here asks “find the row that contains France in column A, and then get 
the value in that row in column B, if you don’t find France, then return an error”. 

 

7.4. Using Index/Match to look from right to left 

Using the Index/Match formula compared to the Vlookup does however result a 
longer formula and for that reason you might want to stay using the Vlookup However 
if we want to do a lookup from right to left instead of left to right i.e. we know the 
person’s name but do not know what country they are from.   

Let’s look at how we can use Index/Match to do a lookup from left to right and find 
out the country a person is from. 

 

 

Figure 47 Using the Index/Match to lookup from left to right 

You can see from the formula that it is almost unchanged – the only difference is that 
the cell ranges have swapped places; 

From right to left: =INDEX(B2:B8,MATCH(“France”,A2:A8,0)) 

From left to right: =INDEX(A2:A8,MATCH(“Melody”,B2:B8,0)) 

 

Exercise 14: Using the Index and Match functions   

Now look at this exercise (page 66) 

 

 

7.5. Index Match Array Formula 

 

You can also use the Index Match Array Function to allow you to search values 
from two columns; this function is very flexible and works well with large amounts of 
data.  
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Figure 48 Index array formula 

 

Firstly you need to select Insert Function from the toolbar and choose Index then 
click OK  as shown below; 

 

Figure 49 Inserting the Index function 

 

From the Select Arguments dialog box choose 
arry,row_num,column_num and click OK .  Then use the 
Cell Picker to select cells C2:18 – then using the mouse click into 
the formula bar and place a comma after C18 and type the word Match – Excel will 
then provide you with two red brackets and the Match dialog box will appear. 
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Figure 50 Match dialog box  

 

In the Lookup_value type or select (using the mouse) cells F3 & F4 (you must type 
the “&”). 

In the Lookup_array select using your mouse the cell range A2:A18 & B2:B18 

Match_type type in the value 0 – this is because you require Excel to give you an 
exact match. 

Then click OK . 

The formula below is indexing from cells C2-C18 (the Salary), it is then matching 
the values in F2 and F3 (Mark Reed) to his First Name in cells A2:A18 (the First 
Name Mark) and Last Name in cells B2:B18 (the Last Name Reed). 

 

 

Figure 51 Index/Match array formula 

 

Note: please do not type in the curly brackets yourself; 
 

Once the formula is created/typed in you need to click into the formula bar and then 
press CTRL+SHIFT+ENTER at the same time which will insert the array function 

for you. 
 

 

Exercise 15: Using Index/Match Array function 

Now look at this exercise (page 67) 
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8 List and Combo Boxes 
We have looked at using Data Validation to create drop down lists – Excel also has the 
a tab called the Developer tab which allows you to use controls – these controls give 
you the option to add buttons, macros, spinners, check boxes and dropdown lists, to 
name a few.  The difference with the dropdown lists used by the Developer tab is that 
they are dependent on a cell and if you move the dropdown lists you have created you 
will also have to format the cell link. 

Before you can use these controls you will firstly need to active the Developer tab, as 
by default it is not already available on the ribbon – see Exercise 1 Add-Ins. 

 

Figure 52 Form Controls on the Developer Tab 

8.1. Creating a Combo Box 

We are going to use the Ria View Theatre Club file to create a variety of combo 
boxes and spinners to make the booking form more user friendly as well as being less 
prone to errors.  Using the Search Facility tab, place your mouse on the cell B12 
under the ID.  

Next we need to choose a combo box from Developer | Controls | Insert | 
Combo Box click on the combo box icon and then draw this over the cell under the 
heading ID (in cell B12). 

 

Figure 53 Creating a combo box 

We next need to ensure that we add form controls to the combo box, right click on 
the on the newly drawn combo box until you have the menu box choose Format 
Control.  The Format Control box has several tabs the one we need to use is the 
Control Tab (should be visible by default once the Format Control is open). 
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We need to choose an input range of data this can be found on the Members tab is – 
Click into the Members tab and select the cell range A2:A51, the cell link is the cell 
that you have just drawn your combo box in which is cell B12.  

Then you need to click OK  – you will then see if you deselect the combo box and then 
click on the drop down arrow a list of Membership IDs to choose from. 

 

 

Figure 54 Formatting the combo box 

We are now going to use an Index formula to enable us to pull through the results from 
the Members ID tab.  Using Index formula, click on the Members tab and select the 
cell range B2:B51 (the Titles), the Cell link will be cell B12 which is where the combo 
box has been drawn. (See formula below). 

 

 

Figure 55 Index formula for title 

 

Repeat this process for Age, Forename and the rest of the details required for the 
members, every time that you choose another Members ID all of the cells should 
update with that Members details.  

8.2. Creating a Spinner 

To make the process easy for the user to change the amount of tickets 
brought by the Member you can create a spinner for the Booking 
Form (under No Tickets), choose spinner from Developer | Controls | 
Spinner and draw this in cell K18 between No Tickets and Total Cost. 
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Right click on the spinner and then choose Format Control, choose your Minimum 
value and Maximum value and the cell link is the cell that you have placed the spinner 
in which is K18, as shown below; 

 

Figure 56 Choosing minimum and maximum value 

 

Now you can use the spinner to decrease or increase the no of tickets brought by 
members; 

 

Figure 57 Using a spinner to decrease or increase amounts 

8.3. Creating a Check Box 

We have a paid field in our Booking form and need to know whether or not 
Members have paid for their tickets, one of the easiest ways of being able to capture 
this is by inserting a Check Box (tick box). 

To do this you firstly need to be on the Booking form tab then in cell F14 under the 
Paid? heading draw a Check Box – Developer | Controls | Insert | Check Box  

 

  

Figure 58 Check Boxes  
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Exercise 16: Creating Combo Boxes, Spinners and Check Boxes   

Now look at this exercise (page 68) 

 

 

8.4. How to create a simple cascading dropdown in Excel 

Making dependant drop-down lists in Excel is easy, all you need is a few named 
ranges and the INDIRECT formula, this methods works with all versions of Excel 
2007, 2010 and 2013. 

We are going to create a cascading dropdown list on location to enable us to choose an 
employee.  Before we begin creating the lists we first need to name the range of cells 
for the location and the employees; 

 

Figure 59 Cells to name 

Highlight the cell range A1:D6, then select Formulas | Defined Names | Create 
from Selection ensure that the Top row remains ticked (this will then name each 
column from the top row of each column). 

 

 

Figure 60 Creating named ranges from a selection 

We next need to be in the cell below location (A10) and then select Data | Data 
Validation – you will then choose List and in the Source you will type =location 
(this is one of the ranges we have just named), then click OK  – see figure 62. 
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You will then see the following drop down list appear in 
cell A10, which will allow you to choose a location.  We 
now need to create another list in the Employees to link 
through to their location. 

 

 

Figure 61 Drop down list 

 

Figure 62 Using data validation to create a cascading list  

 

Now in cell B10 (underneath Employees) we need to also create a list using validation; 
Data | Data Tools | Data Validation, only this time we are going to use the 
INDIRECT formula; 

 

Figure 63 Using the INDIRECT formula  
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We will choose List as we did for our first list but for the source we are going to type the 
following; =INDIRECT(A10) – A10 being the cell that the first list has been created.  
What Excel is doing here is it is checking the first list in the location and depending on 
the value of this list will then choose (from the named ranges you created earlier) for 
each location and will then display the appropriate matching list.  See the results below 
in figure 64. 

 

 

Figure 64 Dependent Cascading List 

 

Exercise 17: Dependant cascading dropdown lists   

Now look at this exercise (page 70) 
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9 What Next? 
Courses offering training in citations management and related topics are 
described below. In all cases, please refer to the IT Learning Programme web 
page (via www.it.ox.ac.uk/courses/) for further details.  

9.1. Further Spreadsheet Courses 

Now that you have some Excel skills you may want to develop them further. The 
IT Learning Programme offers three other Excel courses. 

 

Spreadsheets: Organising and Displaying Data 

Spreadsheets: Summarising data using PivotTables 

Spreadsheets: An introduction to working with statistics 

9.2. Course Clinic 

We encourage everyone to work at their own pace. This may mean that you don’t 
manage to finish all of the exercises for this session. If this is the case, and you 
would like to complete the exercises while someone is on hand to help you, come 
along to one of the Course Clinics that run during term time. More details are 
available from www.it.ox.ac.uk/courses/  

9.3. Further Help 

It may be possible for you to use ITLP facilities in IT Services, Banbury Road to 
work through the exercises in this booklet after the course, or when you don’t 
have access to the applications on your own computer. Contact us on 
courses@it.ox.ac.uk for details. 

The IT Services Help Centre is a good place to get advice about any aspect of 
using computer software or hardware. For Help Centre opening times, visit 
www.it.ox.ac.uk/help/gettinghelp/ and follow links to the General Helpdesk, or 
contact them by email on help@it.ox.ac.uk. 

9.4. Downloadable Course Materials – the ITLP Portfolio 

These course materials are available through the ITLP Portfolio, at 
http://portfolio.it.ox.ac.uk .  

Each course pack includes the course handbook in pdf form and a zip folder of the 
exercise files that you need to complete the exercises. Archive versions of the 
course book may also be useful if you use an earlier version of the software.  

The ITLP Portfolio helps you find articles, videos, resources and weblinks for 
further IT study. For some resources, you will be asked for your Oxford (SSO) 
username and password. 

http://www.it.ox.ac.uk/courses/
http://www.it.ox.ac.uk/courses/
mailto:courses@it.ox.ac.uk
http://www.it.ox.ac.uk/help/gettinghelp/
mailto:help@it.ox.ac.uk
http://portfolio.it.ox.ac.uk/
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Appendix: Student Exercises 

 Implement Add-Ins 

 Add-Ins 

 Adding the Developer Tab 

Refer to page 29 

 

 

Implement Add-Ins 

  

Open any Excel file. 

Click the File tab then select Options in the left panel, 
see below; 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Select Add-Ins and click Go shown at the bottom of the 
window below; 
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Check all the Add-Ins available in the Add-Ins dialog 
box as shown below; 

Select OK, wait for Excel to finish configuring, then 
close the file 
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Activating the Developer Tab 

 

Select the File Tab on the ribbon. 

Choose Options 

Click on Customise Ribbon 

Put a tick in the empty box next to Developer on the 
Main tabs – as shown below then; 

Click OK . 

 

 

 

 

 

 

The Developer tab will now appear on the 
ribbon in between the View and the Nuance 
PDF tabs. 
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 Using SUMIF and COUNTIF functions 

 Use the SUMIF function to sum the value of orders by two different criteria 

 Use the COUNTIF function to count the number of orders by a criteria 

Refer to pages 4-5 

 

Using the SUMIF function sum the 
value of orders by region. 

  

Open SalesAndProduction.x lsx  and open the Sales 
Returns  worksheet. 

Select cell H4 

 

Using the SUMIF function, add up the total value of Sales 
Returns for each region. 

Your formula should look similar to below 

=SUMIF($C$2:$C$31,G4,$D$2:$D$31) 

 

The range will be the Region, range C2:C31 

The criteria will be the name of the Region which you can 
use the cell content reference of G4 for the first region 

The sum range will the range or cells which contain the 
values that you want to add if the criteria is met.  This will 
be range of the Sales Returns D2:D31 

 

It is advisable to make some of the cell references absolute 
so that the function can be copied down from G2 to G5.  To 
achieve this press the F4 key after entering the cell ranges, 
C2:C31 and D2:D31. Cell F2 remains relative so when it is 
copied the new criteria is included in the new formula 

 

Having made relevant cells absolute copy the formula down 
to the other regions. 

 

Add a function in cell H8 to give a total regional summary. 

 

Format the cells to currency. 

 

Using the technique in Step 1 above, use the SUMIF 
function to add the total value of Sales Returns for each 
month.   

Select cell H11  

 

Select  Formulas |  Inser t  Funct ion  button  
, select Category Al l ,

 
and select the SUMIF 

function to view the Function Arguments  
dialog box, 
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This time the range will be the Month, so range will be 
B2:B31 

 

Your Function Arguments  dialog box, should look like 
below. 

 

 

 

Insert any relevant absolute cell referencing and copy the 
results down to cells H12:H14 

 

Add a function in cell H15 to give a total regional summary. 

 

Format the cells to currency. 

 

Your summary of sales will now look like below 

 

 

 

 

 

 

 

 

 

 

 

 

 

Using the COUNTIF function count the 
number of returns per month. 

 

Select cell H18 

This task can be completed in a similar way by entering the 
function, range and criteria directly.   

However there is help on the function if you use 
the Formulas |  Insert  Funct ion  button, 
select Category Al l ,

 
and select the COUNTIF 

function to view the Function Arguments  
dialog box.  

 

The syntax is 

=COUNTIF(range,criteria) 

 

The range  is the range of cells from which you want to 
count nonblank cells, in this example the range are the 
month cells, range B2:B31.   
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The cr i ter ia  is the condition in the form of a number, 
expression, or text that defines the cells to be counted.  In 
this example the criteria is “Jan” .  This can either be typed 

into the formula or a more efficient way is to refer to a cell 
with the criteria in it within your summary so for Jan this 
would be cell G18 

 

Your Function Arguments dialog box will look like below. 

 
 

  

Complete the task by counting the number of sales returns 
for the other three months, either by inserting the formula 
or copying it down after inserting any relevant absolute cell 
references. 

Your summary will now look like below 

Save the file 
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 SUMIFS and COUNTIFS functions 

 Use the SUMIFS formula to calculate sales returns per month and per region 

 Use SUMIFS formula to calculate the total sales per region and per month which 
exceed £20k 

 Use the COUNTIFS function to count the number of sales per month which exceeded 
£20k 

Refer to pages 4-5 

 

Calculate the total sale returns per 
month and per region using the 
SUMIFS function 

 

  

Open SalesAndProduction.x lsx   or if you did not 
complete Exercise 2 open the file 
SalesAndProduction Ex 2 completed.xlsx  

Select cell K4 

 

Insert the first SUMIFS function using two criteria to 
calculate the total sales for the North  in January .  The 
first criteria will be Month  =Jan  and Region = 
Nor th  

 

The sum range will be the Sales  Return  column, 
D2:D31 

 

The 1st Criteria range will be the Month  column, 
range B2:B31 

The criteria for the 1st range will be K3 or “Jan” 

 

The 2nd Criteria range will be the Region  column, 
range C2:C31 

The criteria for the 2nd range will be J4 or “North” 

The formula is 

=SUMIFS($D$2:$D$31,$B$2:$B$31,K3,$C$2:$C$

31,J4) 

 

If using the Insert Function button in the 
Function Library group on the Formulas 
tab it will look as below. 
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Insert the functions for each month and each region.  
This can either be done by considering what absolute 
references to use or insert each individually. 

If you are considering using the absolute referencing 
consider which ranges or cells require which level to 
make absolute. 

Tip: You will need to make the ranges for Sales 
Returns, Month and Region absolute and Month 
criteria requires the row reference making absolute, so 
the $ sign needs inserting in front of the number only, 
e.g K$3.  For the Region the column reference will be 
absolute, so the $ sign needs inserting in front of the 
column reference only e.g $J4.  For example the 
formula for the month of January and the South region. 

=SUMIFS($D$2:$D$31,$B$2:$B$31,K$3,$C$2:$C$31,
$J4) 

 

 

Format as Currency and Total each column total. 

Your Total Sales per Month, per region results will be as 
below 
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Calculate the total sale returns per 
region which exceed £20k, using the 
SUMIFS function 

 

 

Using cells Q4, Q5, Q6 and Q7 insert the SUMIFS 
function to calculate the total Sales  Returns  for each 
Region  that exceeds £20,000.   

 

The formula for the North  region will be 

=SUMIFS($D$2:$D$31,$C$2:$C$31,P4,$D$
2:$D$31,">20000") 

 

This time the criterion for the exceeding 20000 is not 
referring to a cell reference so needs to be inserted 
between quotation marks.  You also do not need to 
include the £ sign or any commas between the 
thousands) 

 

Copy down to the remaining regions 

 

Insert a total and format to currency 

 

Your results should be as follows 
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Calculate the total sale returns per 
month which exceed £20k, using the 
SUMIFS function 

 

In cells Q11, Q12, Q13and Q14 insert the SUMIFS 
function to calculate the total Sales  Returns  for each 
Month   that exceeds £20,000 

 

The formula for Jan will be 

=SUMIFS($D$2:$D$31,$B$2:$B$31,P11,$D$2:$
D$31,">20000") 

 

Copy down to the remaining regions 

 

Insert a total and format to currency 

 

Your results should be as follows 

 
 

 

Calculate number of sale returns per 
month which exceed £20k, using the 
COUNTIFS function 

 

In cells Q18, Q19, Q20and Q21 insert the COUNTIFS 
function to calculate the total Sales  Returns  for each 
month  that exceed £20,000 

 

The formula for Jan will be 

=COUNTIFS($B$2:$B$31,P18,$D$2:$D$31,">20
000") 

 

Copy down to the remaining regions 

 

Insert a total 

Your results should be as follows 
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 Invoice Vlookup – Exact match  

 Using the Vlookup function to complete an invoice 

Refer to pages 6-7 

 

This task it to insert the Vlookup  

formula to complete the Descr ipt ion , 

Uni tSize  and Uni tCost  details in an 

invoice. 

 

  

Open Invoice lookup.xlsx  

There are two worksheets in this workbook.  One named 
Invoice  and the other named Stock  l is t  

Take a look at both worksheets and familiarise yourself 
with what they contain. 

Open worksheet Invoice . 

 

In column A  the StockCode  column contains a 
validation list linked to the Stock  l is t  worksheet.  By 
selecting a StockCode  from the list will prevent errors 
when creating the remainder of the invoice, as only a 
valid StockCode  can be selected. Column F  the Total  
column also contains a formula which will calculate the 
total when a StockCode  is inserted. 

 

You are now going to insert Vlookup  formulas to locate 
the Descr ipt ion , Uni tSize  and Uni tCost  based on 
the StockCodes  you select.   

The Num  ordered  column will be input by you and the 
Total  column will also calculate as it contains a 
formula. 

 

Select StockCode J1F0 1179 from the validation 
drop down list. 

 

Enter the Vlookup  formula for 
Descr ipt ion  

 

In Cell B6 enter a vlookup formula to locate the 
Description. 

 

 

To look up the Descr ipt ion  in cell B6  your formula 
will be as follows 

Your completed formula will be 

=VLOOKUP(A6,StockTable,2,FALSE) 

Your Invoice will now look as below 
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Following the same process in Error!  Reference 
ource not  found.  from Task 1 and insert a vlookup 
formula to complete the Uni tSize  in cell C6 for Stock  
code  J1F0 1179. 

 

To look up the Uni tSize  in cell C6  your formula will 
be as follows 

Your completed formula will be 

=VLOOKUP(A6,StockTable,4,FALSE) 

Cell C6  will now contain ‘Single’ 

 

Enter the vlookup  formula for 
Uni tCost  

Consider the cell reference of A6  in 
your vlookup formula in cell C6  and 
make to an appropriate absolute cell 
reference which will then allow you to 
copy it to cell D6 . 

 

Previously you have typed in the vlookup  formula 
however you can also copy it and amend the column 
index num  to receive the correct return value, in order 
to save some time. 

Select cell C6  and click into the formula bar, change the 
reference to cell A6  from a relevant reference to an 
absolute cell reference.  However consider where your $ 
needs to appear.  If you click into the formula and select 

A6 , press <F4> twice.   

This will insert a $ before the A but NOT before 6 so will 
show $A6.  By doing this when the formula is copied 
across it will fix the reference to row A and when the 
formula is copied down the invoice it will amend the 
row number. 

 

Copy the contents of cell C6  over to D6  

 

Your new formula in cell D6  should now be  

=VLOOKUP($A6,StockTable,5,FALSE) 

Cell D6  will now contain 5.06 

  

Enter a value of 30 in cell E6  

The total will calculate with the formula which has 
already been inserted. 
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Enter a value for number ordered and 

copy the vlookup formula to the bottom 

of the invoice, 

 

Select cells B6 to D6 and hover your mouse over the 
bottom right corner of the cell range.  The Autofill + 
sign should appear. 

 

Click and hold the left mouse button and drag the 
Autofill down to row 23 and release the mouse. 

Your invoice will now look as follows. 

 

 

  

Insert a new record to your invoice for StockCode  
J5D0AL 1003 with the Num ordered being 20 

Your invoice will now look like below 

 
 

 

Enter a formula to remove the error 

message of #N/A 

 

There are currently errors in cells B8:D23.  This is 
owing to the StockCode being blank and the 
VLOOKUP formula cannot locate a result for 
Description, UnitSize or UnitCost.  To prevent this 
you can insert a formula to bring back a blank cell if this 
happens. 

Insert the following IFERROR formula in the cell range 
B8:D23  by first selecting cell B8  and inserting the 
below formula.  I have emboldened the additional part. 

=IFERROR(VLOOKUP(A8,StockTable,2,FALSE),"") 

 

Copy the formula down from B8  to B23 . 
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Select cell C8  and insert the same additional formula 
and copy down to cell C23 . 

 

Repeat this again for cell D8  and copy down to D23 . 

 

All errors should now appear and it is also advisable to 
test your formula by inserting a new stock code and 
double checking it is correct to the Stock list. 

 

Save and close your file. 

 

 

 Invoice Vlookup – Inexact match  

 Using the Vlookup function to complete an invoice 

Refer to pages 6-7 

 

This task it to insert the Vlookup  

formula to complete the Grade for 

Exam Results based on the percentage 

the student achieves. 

  

Open Exam Grades.xlsx  

There are two worksheets in this workbook.  One named 
Resul ts  and the other named Grades 

Take a look at both worksheets and familiarise yourself 
with what they contain. 

 

You are now going to insert Vlookup  formulas to locate 
the Grade , based on the percentage achieved.   

Look at the percentage results in column B  of the 
Resul ts  worksheet.  The percentages here contain 
values like 63%,  90%  and 84%.  

 

Now take a look at the worksheet Grades 

The grades are based on the below percentages. 

Percentage Grade 

0% Fail 
60% C 
70% B 
80% A 
90% A* 

 

With this in mind an inexact vlookup formula will be 
required to obtain the correct grade.  Please refer back 
to Section Error! Reference source not found. for 
 recap. 

  

Select cell C4 in worksheet Resul ts  
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To look up the Grade  for cell C4  your formula will be 
as follows 

Your completed formula will be 

=VLOOKUP(B4,GradeTable,2,TRUE) 

  

Copy the formula down from cell C4  to the bottom of 
the results in cell C15 

Your completed exam results will look as follows 

Save and close the file. 

 

Save and close your file. 

 

 

 Manual What-If Analysis 

 Manually inserting values to cells to see the changes in profit 

Refer to pages 8-11 

The company produce three types of units.  Company profit is determined by changing the 

two variables in B4 (Hourly Rate), and B5 (Materials Cost).   

 

 

Change the Hourly Rate and Materials 
Cost to see the change in Total Profit 
and Total Profit per model 

 

 

Open SalesAndProduction.xlsx.  Open the 

Production Costs worksheet. 

 

Using the Options in the range H5:I7 as 
a guide establish the possibilities for 
Total Profit by changing the Hourly 
Rate and Materials Cost in cells B4 and 
B5. 

 

 

 

Select cell B4 and insert the Best case Hourly Rate of 30 
and the Materials Cost of 57.  The profit should change 
to £17,988 

 

Select cell B4 and insert the Best case Hourly Rate of 38 
and the Materials Cost of 62.  The profit should change 
to £7,482 

 

Select cell B4 and insert the Best case Hourly Rate of 34 
and the Materials Cost of 59.  The profit should change 
to £13,008 

 

Re-insert your original values.  The Hourly Rate was 32 
and the Materials Cost was 59 
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Your next exercise will look at an efficient way of showing these different results and also save the 
original values by using Scenario Manager .  You can subsequently view each case when the file is 
opened in the future.   

Save your file 

 

 

 

 

 Using the Scenario Manager 

 Adding scenarios 

Refer to pages 8-11 

 

In this task you will add four scenarios 
using the scenario manager to insert 
the original values, best case, worst 
case and likely case. 

 

 

Open SalesAndProduction.x lsx  or if you did not 
complete the previous exercise open the file 
SalesAndProductionEx3 completed.xlsx  

 

From the Data |  Data Tools  tab click the 
What- I f  Analysis    button and choose 
Scenario Manager   

Select Add . 

 

In the Add Scenario  dialog box, in Scenario name:  
add Original. 

 

In Changing cells: text field add cells which 
contain the amounts for hourly rate, cell B4 and 
material cost, cell B5.  Changing cells will contain 
$B$4:$B$5. 

 

Select OK  

 

In the Scenario Values  dialog box the Hourly Rate 
should contain 32 and Material Cost will contain 59 as 
these are the current values 

Select Add  in the Scenario Values dialog box. 

Now insert your next scenario by 
selecting Add from the Scenario 
Manager dialog box. 

 

 

 

In the Add Scenario  dialog box, in Scenario name:  
add  Best case 

 

 

In Changing cel ls : text field add cells which contain 
the amounts for hourly rate, cell B4 and material cost, 
cell B5.   

Select OK.  
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In the Scenario Values  dialog box add Hourly Rate 
as 30 and Material Cost as 57 

Select Add  in the Scenario Values dialog box. 

 

Complete the Add Scenario  dialog box adding the 
remaining cases, Worst and Likely with the necessary 
data.  On entering the lase set of Scenario values for the 
Likely case select OK  

When all scenarios have been inserted, select a scenario 
from the Scenario Manager dialog box and select 
Show.  

 

View each scenario 

 

To view the three scenarios and see how the Total 
Profit Changes.  You may need to move the 
Scenarios dialogue box to view the figures 
changing. 

Once the Scenario Manager window has been closed you 
can view the scenarios again by selecting the Data |  
Data Tools  |What-I f  Analysis |  Scenario 
Manager then select the scenario name and select 
Show.  

 

Create a scenario summary report 

 

Select Data | Data Tools | What-If Analysis | 
Scenario Manager | Summary  

 

 

The Scenario Summary dialog will appear.  The Result 
cells should contain the value of B6. 

Select OK  
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 Use formula with the Scenario Manager 

 Adding scenarios and using formula 

Refer to pages 8-11 

The worksheet you will now be working in contains the operating profit for the company. 

You will be required to change some of the Overhead Costs and the Average Customer visits 
either by a percentage of their current value or changes the value directly, to see the worst 
case and best case of the Operating Profit. 

 

Add three scenarios using formulas in 

scenario manager. 

  

Open SalesAndProduction.x lsx or if you did not 
complete the previous exercise open the file 
SalesAndProductionEx5 completed.xlsx  

Open the worksheet Operat ing Prof i t  

 

Select Data |  Data Tools  |  What - I f  Analysis |  
Scenario Manager   

 

In the Add  Scenario  / Scenario  Name  insert 
Original. 

  

The Changing cells are $D$9,$D$10,$D$12,$C$6 

Select OK  

 

 

 

In the Add  Scenario  / Scenario  Name  insert 
Operating Profit (worst case) 

 

The Changing cells are the same as before so should still 
be in the changing cells box as D$9,$D$10,$D$12,$C$6 

Select OK  

 

In  the Scenario Values  dialog box enter the values 
as shown for the Best  Case  scenario below. 

It is important to add an = sign for formulas. 

When all four scenario values have been entered Select 
Add.  

 

The warning dialog box shown below indicates that the 
formula entered will be turned to values.  Select OK  

Now add the Worst Case scenario  

Your Scenario values should look like below. 

Select OK  

 

Once again acknowledge the conversion into values by 
selecting OK  
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The Scenario Manager  dialog box will appear again. 

Select a Scenario and use the Show  button to view the 
results of the three scenarios 

The original operating profit was £11,621,306 

The best case operating profit should be  

£12,322,299.03 

The worst case operating profit should be  

£12,111,037.10 

 

Create a Scenario Summary Report with the Result cells 
as D16. 

 

 

 Data Validation 

 Validating numerical data 

 Validation text length 

 Validating Dates 

 Using validation lists 

 Using formula to create validation rules 

Refer to pages 12-17 

 

Validating numerical data – we are 
going to add a validation rule to the 
ages on the booking form. 

  

Open the file HealthClubBookings.xlxs 

 

Highlight all of the cell range for column B. 

 

Select Data | Data Validation 

Choose Whole Number from the Allow drop down 
box. 

 

Using the Rules on the spreadsheet for Age using your 
mouse select cell J5 which is the Minimum Age 
allowed (the value 17) 

 

For the maximum amount select cell J6 (which is the 
value 100 – maximum age). 

Insert an Input message for users   

Click on the Input Message tab  

Give it a Title of Age with the following Input Message; 

Ages must be whole numbers in the range of 17-
100. 
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Inserting an Error Alert Message  

Click on the Error Alert tab. 

Select the Style you require; choose either Warning, 
Stop or Information. 

Title: Invalid Age 

Error Message: Age is usually between 17 and 100.  
Are you sure this is correct. 

 

Click OK . 

Checking validation works  

Check that the validation has worked by changing Kyle 
Suttons’ age to 16. 

 

Using validation to specify a minimum 
and maximum length. 

 

Continue to use Health Club Bookings file 

 

Highlight all of the cell range for column B. 

 

Select Data | Data Validation | Choose Text 
Length | Between | Minimum J12 | Maximum 
J13. 

Add an Error Alert Message  

Add the following Error Alert Message; 

Names must be at least two characters and not more 
than twenty characters. 

Click OK . 

 

Check the validation rule works correctly by entering a 
new entry into the bookings form. 

 

Inserting a validation rule to control 
dates are not before today’s date. 

 

Continue to use Health Club Bookings file 

 

Highlight all of the cell range for column A. 

 

Select Data | Data Validation | Choose Date | 
Greater than or equal to  

Then type in the following formula =TODAY() 

 

Enter an appropriate Input Message 

 

Enter an appropriate Error Alert Message 

Click OK  
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Check that the validation is working correctly by trying 
to add a new entry with the date 20th June 2015. 

 

Creating a validation list for users to 
choose from a drop down list. 

 

Continue to use Health Club Bookings file. 

 

Highlight cells D7:D20 

Then select Data | Data Validation | Choose List  

For the Source using your mouse select the cell range; 
J25:J30. 

Add an Input Message   

Now add an appropriate Input Message. 

Add an Error Message Alert   

Now add an appropriate Error Message Alert. 

Click OK . 

 

Check that the validation is working correctly by trying 
to add a new entry and choose from the list. 

 

Use a formula to create a validation 
rule for a discount. 

 

Continue to use Health Club Bookings file. 

 

Highlight of the cell range for column F. 

Then select Data | Data Validation | Choose 
Custom  

Then add the following formula: 

=IF(E7<10,FALSE,TRUE) 

Add an Input Message  

Add an appropriate Input Message for users. 

Add an Error Message Alert  

Add an appropriate Error Alert Message for users. 

Click OK . 

 

Check the Validation is working correctly by entering 
either a new entry or changing the Price on a booking 
already in your booking form. 

  

Save and Close the file. 
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 Conditional formatting by highlighting cells 

 Using conditional formatting to highlight cells which are of above average grade 

Refer to pages 18-28 

 

Use conditional formatting to highlight 
cells which are above average grade. 

  

Open Exam Grades.xlsx  or if you did not complete 
the previous exercise open Exam Grades Ex11 
completed.xlsx  

 

Select cells B4:B15. 

 

Click on the Condi t ional  Format t ing |  Top 
Bot tom Rules |  Above Average |  Green Fi l l  
wi th  Dark  Green Text  from Styles. 

 

Click OK.  

Save and close the file. 
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 Conditional formatting with visualisations 

 Using conditional formatting to insert data bars for each months sales returns 

Refer page 23 

 

Open January’s sales.  Use a formula to 
request data in different colours to 
illustrate the values. 

 

  

Open SalesAndProduction.x lsx or if you did not 
complete this exercise use the file 
SalesAndProduction Ex8 completed.xlsx  

Open worksheet Sales Returns .  

 

To insert Data Bars first we are going to create a formula 
in the cell adjacent to the values in cells D2:D31 

Click into cell E2 

Type the following formula =D2  

 

Now copy this formula down for the rest of the cells – do 
this by placing your mouse on the black square in the 
right hand corner of the cell you have just created the 
formula in and dragging down. 

 

 

Select cells E2:E7. 

Click on the Condi t ional  Format t ing |  Data Bars |  
More Rules  |  from styles. 

 

Put a tick in the box Show Bar Only  

For Bar Appearance choose Fi l l  |  Gradient Fi l l  |  
Border  |  No Border.    

Click OK . 

 

Insert data bars with a different colour 
for February. 

 

 

Continue working with the 
SalesAndProduction.x lsx   

Select cells for Feb E8:E17. 

 

 

Click on the Condi t ional  Format t ing |  Data Bars |  
More Rules  |  from Styles. 

Put a tick in the box Show Bar Only  

 

 

For Bar Appearance choose  Fi l l  |  Gradient Fi l l   |  
Border   |   No Border  Choose a different gradient 
colour from Jan 

Click OK.  
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Now repeat the above process for each month, with 
different colours for each of the months. 

Save and Close. 

 

 

 Formula driven conditional formatting 

 Using formulas to conditional format cell ranges 

Refer to page 27 

 

To create conditional formatting using a 

formula. 

  

Open Exam Grades Ex11.xlsx and open the 
worksheet Results 

Select Cells B4:B15. 

 

Click on the Condi t ional  Format t ing |  New Rule |  
Use a formula to determine which cel ls  to  
format  from Styles. 

In the Format values where this formula is true 
add the following formula;  

=B4<AVERAGE($B$4:$B$15). 

 

Then select the format button 

Choose Fill and select a colour to fill the cells that are 
below average 

Click OK.  

 

Now re-visit the formula and change the below (less 
than sign <) to a above (more than >sign) and see how 
this affects the results of the percentage grades 

Save and close the file. 

 

 

 Managing multiple conditional formats 

 Using formulas to conditionally format cell ranges 

Refer to pages 26 

  

To create conditional formatting using 
multiple rules to display different 
colours for the different conditions; 

 

Open Exam Grades Ex11.xlsx and open the worksheet 
Results 

Select Cells C4:C15 
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Click on the Condi t ional  Format t ing |  New Rule |  
Format  only cel ls  that contain  from rule type. 

In the Format only cells with;  

Select Equal to from the drop down box 

Type A* in the next box. 

 

Then select the format button 

Choose Fill and select a colour to fill the cells that are 
below average. 

Then select OK . 

 

Repeat the above process for A, B, C. 

 

Save and Close the file. 

 

Clear or Edit Conditional Formatting 

 

 

To edit conditional formatting rules, use the 
exercise you have just completed setting conditions 
for the exam results;   

Firstly select the cells which contain the conditional 
formatting rules 

Then select Condi t ional  Format t ing |  Manage 
Rules  

 

 

 

You will then see the following dialog box, this details all 
the conditions you have set for those cells. 

This dialog gives you three options New Rule,  Edi t  
Rule and Delete Rule.  

 

To simply clear the conditional formatting from 
cells or the entire work sheet try the following; 

Select the cells containing the formatting and then select 

Condi t ional  Format t ing |  Clear  Rules . 

 

Then you have two options Clear rules from 
Selected Cells and Clear Rules for Entire Sheet 

Save and close the file. 
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 Index and Match Functions 

 Create an Index Function  

 Create a Match Function 

 Combine Index and Match  

Refer to pages 29-31 

 

Using the Index function to find the 
result in row 3. 

 

Open the file Index and Match.xlsx 

 

Click into cell B10 on the ribbon select Formulas | 
Insert Function | Index 

Choose array,row_num,column_num 

 

In the Array using the cell picker select the cell range 
A2:A8. 

In the Row_num using the cell picker and select cell 
B11. 

Click OK . 

 

Excel will then return the value of “India”. 

 

Using Match to find Bridget from the 
list. 

 

 

Continue to use the file Index and Match.xlsx. 

 

 

Click into cell B14 on the ribbon select Formulas | 
Insert Function | Match 

 

In the Lookup_value use the cell picker to select the 
value in cell B15. 

In the Lookup_array use the cell picker to select the 
cell range B2:B8 

In the Match_type type the value zero (this is for an 
exact match). 

Then click OK . 

 

Excel will then return the value of 4 which is exactly the 
cell that “Bridget” is in. 

 

Save and close the file. 

  

Open the file Index and Match together.xlsx. 
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Using Index Match together to return a 
person and their country. 

 

Click into cell B10 on the ribbon Formulas | Insert 
Function | Index 

In Array use the cell picker and select cell range 
B2:B8. 

 

Now click into the formula bar after B8 and place a 
comma and then type the word MATCH and an open 
bracket. 

This will then open up the MATCH function arguments. 

 

In the MATCH function arguments Lookup_value 
type the word France. 

In the Lookup_array use the cell picker and select the 
cell range A2: A8. 

In the Match_type type a zero for an exact match. 

Click OK . 

 

Excel should now return the value Melody. 

Save and close the file. 

 

 

 Using the Index Match Array Function 

 Use the Index Match Array function 

Refer to page 31 

 

You are going to use the Index Match 
Array function to search for values 
from two columns. 

In this case we are going to be looking 
for the salary of staff. 

 

 

  

Open the file Index Match Array.xlsx. 

 

 

Click into cell F5 on the ribbon select Formulas | 
Insert Function | Index. 

Choose array,row_num,column_num and click 
OK.  

 

In the Lookup_value use the cell picker to select the 
value in cells C2:C18. 

Then using the mouse click into the formula on the 
formula bar and put a comma after C18 and type the 
word Match – Excel will then provide you with two red 
brackets and the Match function arguments will 
open. 
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In the Lookup_value type or select cells F3&F4 (you 
must type the “&” sign). 

In the Lookup_array select using the mouse the cell 
range A2:A18 & B2:B18 (again make sure you type the 
“&” sign) 

In the Match_type enter a zero. 

Then click OK . 

 

Once you have created the formula to ensure it works as 
an array function you will need to add curly brackets – 
you must not type these in by hand! 

Use the mouse and click into the formula on the formula 
bar then press CTRL+SHIFT+ENTER at the same time 
which will then insert the curly brackets for you. 

Your function should now work correctly. 

 

Test the function works correctly by typing in another 
First Name and Last Name 

 

 

 

 Lists, Spinners and Combo Boxes 

 Create Combo Box (drop down) lists to choose options 

 Use Spinners to change the number on the page  

 Creating a Check List for payment 

Refer to pages 34-36 

 

 

You are going to add some features to 
booking and search form 

 

  

Before you can begin this exercise you will need to have 
completed Exercise 1 – adding the Developer Tab. 

Open file Ria View Theatre Club.xlsx. 

 

Open the Search Facility Tab and place your mouse on 
the cell B12. 

Select Developer | Controls | Insert | Combo Box 
then draw this combo box over the cell B12. 

 

We no need to add form controls to this combo box; 

Right click on the combo box you have just drawn and 
choose Format Control. 
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For the Input Range click on the cell picker and go to 
the members page and select the cell range A2:A51 

In the Cell Link type in B12 (which is the cell where the 
combo box has been placed). 

Click OK . 

 

Using the Index formula to link the 
combo box to the data on the 
Members tab. 

 

 

On the Search Facility page select cell C12. 

Either; 

Use the Formula tab on the ribbon and choose Index 

Formulas | Insert Function | Index | 
array,row_num,column_num then the following; 

Array – use the cell picker and select the cell range 
B2:B51 from the Members page  

Row_num – B12 (the cell where the combo box is 
placed on your search facility page). 

Click OK . 

OR 

Type in the following formula 
=INDEX(Members!B2:B51,B12) 

 

Complete the steps above for Age, Forename, 
Surname, Town, Postcode and Contact Number 

 

 

Checking the Index formula works. 

 

 

Use the combo box to change the ID of the members to 
ensure that the index formula is working correctly. 

 

Create a Spinner to increase or 
decrease the amount ordered. 

 

 

Continue to use the Ria View Theatre Club.xlsx file. 

Open up the Booking Form tab and in between the cells 
No Tickets and Total Cost (cell K18) insert a Spinner 
from the Developer tab; 

Developer | Controls | Insert | Spinner  

 

Right click on the spinner then choose Format Control. 

Leave the current value as zero. 

Minimum value as 1. 

Maximum value as 15 

Cell link J18 (which is the cell before the spinner as that 
is where you want it to display the values). 

Then click OK . 
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Test the spinner works by clicking on it to either 
increase or decrease the value of the order. 

 

Creating a Check Box for whether 
members have paid or not. 

 

 

Continue to use the Ria View Theatre Club.xlsx file. 

Continue with the Booking Form tab and in the cell F14 
underneath the Paid? cell you are to insert a Check Box 
from the Developer tab; 

Developer | Controls | Insert | Check Box 

 

Adding Validation to the Date of 
Booking. 

 

In the cell underneath Date of Booking use a validation 
rule so that dates cannot be entered before today. 

 

Make sure that you use appropriate Input and Error 
Alert messages for the user. 

Test the validation works by changing the dates. 

 

Enter a validation list for the Method 
of Payment. 

 

In cell G14 (underneath the Method of Payment) create a 
validation list for the different methods of payment. 

Data | Data Validation  

 

In the Allow – choose List 

In the Source – use the cell picker to navigate to the 
Method of Payment page and select the cell range A2:A5 

Click OK . 

 

Make sure that you use appropriate Input and Error 
Alert messages for the user. 

Test the validation works by changing the method of 
payment. 

 

 

 Creating a dependent cascading list  

 Create a dependent cascading list 

Refer to page 37 

 

 

You are going to create a dependant 
cascading drop down list to choose an 
employee from their location. 

  

Before you can begin this exercise you will need to have 
completed Exercise 1 – adding the Developer Tab. 

Open file Dependent cascading dropdown 
lists.xlsx. 
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Before we begin to create the lists we first need to make 
sure that we have named the ranges of cells in our 
worksheet. 

Select all cells A1: D6 

Formulas | Create from Selection 

Put a tick in the Top row only 

Click OK . 

 

Click into cell A10 underneath the heading Location. 

Data | Data Validation 

In Allow choose List 

In Source type =Location 

Click OK . 

 

Next click into cell B10 (underneath Employees). 

Data | Data Validation 

In Allow choose List 

In Source type =INDIRECT(A10) 

Click OK . 

 

 

Test that they both work by first clicking on the drop 
down box under location and choose Bristol. 

Then click onto the list under employees and check that 
you have the list of three names for Bristol; Harry, 
Paul and Tim. 

 

Save and close the file. 
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IT Learning Programme

Excel Advanced Data Analysis
and Modelling

Traci Huggins

Today’s arrangements …..

Your teacher is: Traci Huggins

Your demonstrator is:

We finish at:

This is a hands-on session so get stuck in and have
fun – don’t be afraid to experiment!

Your comfort is important

The toilets are along the corridor just outside the
teaching rooms

The rest area is where you registered;
it has vending machines and a water cooler

The seats at the computers are adjustable

You can adjust the monitors for height,
tilt and brightness

Add-Ins …….

During this session you will be using functions and
features that are not available by default.

These functions and features need to be added
into Excel – to activate the Add-Ins;

File | Options | Add-Ins |

Then select the Add-Ins available – Instructions in
Exercise 1 (page 41) …

What we will cover today …..

 SUMIF & COUNTIF

 SUMIFs & COUNTIFs

 VLOOKUP

 Inexact Match

 Exact Match

 Scenarios

 Summary Reports

 Goal Seek

 Solver

 Conditional Formatting

 Criteria

 Data Bars

 Colour scales

 Icon Sets

Excel 2010: A Quick Tour/Refresher

The Grid/Data Sheet: where
your data goes, in columns
and rows

The Ribbon/Toolbar: where the menus are

The File Tab: called ‘Backstage view’ – where you go for
printing, saving and creating new files
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Quotation marks in formula/Refresher

IMPORTANT: Any text criteria of any criteria that includes logical
or mathematical symbols must be enclosed in double quotation
marks (“). If the criteria is numeric double quotation marks are not
required.

Examples:

=SUMIF(A2:A5,">160000",B2:B5) – Quotation marks are needed here
because we have the more than sign included in the formula.

=SUMIF(A1:A7,"Fruits",C1:C7) – Again quotation marks are needed
as we are using text in the formula.

=SUMIF(A2:A5,300000,B2:B5) – Quotation marks not needed here as
the criteria is a numerical only.

SUMIF and COUNITIF Functions

SUMIF
Allows you to sum values that meet a single criteria

=SUMIF(range, criteria, sum_range)

Range: is the range to evaluate

Criteria: is the search value to be applied to the range

Sum_range: is the range containing values you want to
summarise

Lets look at an example of how this works;

SUMIF example …. COUNTIF – Example….

COUNTIF works
the same as the
SUMIF, however
COUNTIF counts
the criteria you
require rather
than adds them
up

SUMIFs …….

Both the SUMIFs and COUNTIFs allow you to find the sum of values
in your data that meets multiple conditions see below;

=SUMIFS(sum range, criteria range 1, criteria 1, Criteria range 2,
criteria 2) where;

Sum Range: are the actual cells to sum
Criteria Range: are the range of cells you want evaluated of a
certain condition
Criteria: Criteria: is the condition or criteria in the form of a
number, text or formula

=SUMIFS(B2:E2, B3:E3, ">3%", B4:E4, ">=2%")

criteria
range1

Sum
range

criteria1 criteria
range2

criteria2

SUMIFs example ….
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COUNTIFs ……

As with the SUMIFs the COUNTIFS allow you to count
values that meet certain multiple criteria;

=COUNTIFS(criteria range1, criteria1, criteria range2, criteria2…..)

Criteria range - is the range of cells you want to evaluate for a
particular condition
Criteria - is the search value to be applied to the range

=COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes")

criteria1 criteria
range2

criteria
range1

criteria2

COUNTIFs example …

Lookup Formulas …….

Vlookup – Exact match

=VLOOKUP(A6,'Stock list'!$A$2:$E$19,2,FALSE)

Vlookup – Inexact match

=VLOOKUP(B4,'Grades Table'!$A$2:$B$6,2,TRUE)

What IF Analysis ……..

What-if analysis is the process of changing the values
in cells to see how those changes will affect the
outcome of formulas on the worksheet.

Three kinds of what-if analysis tools come with
Excel: Scenarios, Data Tables and Goal Seek.

We will look at each one of these in turn

Scenario Manager …….

The Scenario Manager makes it easy to automate
your What-If models.

Its possible to store different sets of input values
for any number of variables and give a name to
each set.

Scenario Manager …….
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Summary Reports ……..

Example;

Exercises – SUMIF, COUNTIF, VLOOKUP &
Summary Reports/Scenario…

Complete Exercises 1- 7

Your files are on H:\

Start at Student Exercises, page 41 .............

Please ask for help if needed!

Data Validation …….

Use Data validation to set rules on individual or a range of cells

Use the Input Message and Error Alert to inform users of what is

expected to be in the cells …

Conditional Formatting …….

Below are the various types of conditional
formatting;

 Format a cell based upon the cell value
 Format duplicate Values
 Visualisations
Data Bars
 Colour Scales
 Icon Sets
 Formula Driven

Index / Match ……. Using the Developer Tab …….
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Exercises – Scenario’s and Conditional
Formatting

Complete Exercises 59-71

Your files are on H:\

Start at Student Exercises, page 59 .............

Please ask for help if needed!

Other Spreadsheet Courses ….

Excel : Analysing your spreadsheet data with pivot tables

Excel : 3D formulas, charts and securing your data

Excel : Working with lists and querying external data

Excel: Checking and Managing Data

Other Courses …….

• Course Clinic

• Office Fundamentals

ITLP Portfolio;

http://portfolio.it.ox.ac.uk/ traci.huggins@it.ox.ac.uk

This presentation is made available under a Creative Commons

licence: Attribution, Non-Commercial, Share Alike.

Individual images are subject to their own licensing
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